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Highlights of ZW3D 2021

Basics: New “Command Search”
New “Map Key”
Translator: Adjustment to “Quick Import”

Convert Attributes Support

CAD: New “Equal Curvature”

New “Cosmetic Sketch”

Modeling Dimensional Accuracy Update

Complete CSYS Support

New Cross-section Type “G2 Blend” in Fillet Command

"Blend Face" Command New Option "G2 Blend"

"Fillet Open Faces" command New sub menu "Shape of Fillet"

New “Zero Radius Flange”

New “Clearance Check”
New “Batch Attribute Edit”

Drafting: New “Point Table” and “Dimension Table”

CAM: Enhancements of Full Machine Simulation

The Rough Turning Operation Supports Arbitrary Contour as Stock

New Arc Fitting Functionality in Surface Engraving Operation and 5X Operations

New Excel Format of Operation List

Support the G68.2 Functionality

Note: Important enhancements in this article are marked with *


Map_Key#_★New_
Quick#_★Adjustment_to_
Equal_Curvature#_★New_
Zero_Radius#_★New_
Clearance_Check#_★New_
Batch_Attribute#_New_
Point_Table#_★New_
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1 Basic

1.1 Ul & Workflow
1.1.1 % New “Command Search”

Use “Command Search” to search by character matching and each search history will be recorded. The
search records are ordering by time with the latest ones ahead. The search object includes the command
name and the command description. As for search results, they will display in multiple pages with each
page of 30 items and provide the functions of the page running and page number. Support dynamic
displaying the search result command in current Ul. User can directly execute the command search, but
only limit to the command in the current environment.

£ Trim 1| oy e

YT BX

Stock  Add | Divide | Face  Simplify Replace Resolv

Shape»| =~ Offset Selfx
¥ Commanc q& Divide 2
—5Search =
GEE Trirn
Trim : | )
—48 matched itemns for : Trim
s

it Trim
Trim away part of a solid or open shape (B) E
where it intersects with faces, shapes, and/or
datum planes (T). The amows (5] indicate the
side to keep.
Quick access menu: &Edit - Shape ¥ Trim
Ribbon tab: Electrode = Assist Tools =%
Divide(Drop down) =+ Trim
Ribbon tab: Shape =¥ Edit Shape =
Divide(Drop down) =* Trim

¥= Trim

Trim between two weldment structural.
Ribbon tab: Weldments = Frame = Trim

[ Trim <

- 1/2 -

Close
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1.1.2 % New “Map Key”

“Map Key” supports recording the workflow of a single command or multiple command groups to meet
quick completion of some batch design operation. User can input parameters for template command
and can add, delete, modify, and save “Map Key”.

Definition of “Map Key”

(1) “Map Key” supports all combinations of letters and numbers with 32 maximum
characters.

(2) The widget layer will disable user’s input once irregular character input happens (such as
control character and special character). All irregular input will be disposed in the method
of neglect.

Add, delete, modify, and save “Map Key”
1. Support addition of “Map Key”

(1) Required inputs include “Map Key” and Name (64 maximum characters) while Description is
optional input. To select record action is supported.

(2) When “Map key” is empty, click OK and the interface will be saved, in case of user losing the
recording and input text when the user forgets to input “Map Key”.

2. Support deletion of single or multiple “Map Key”

(1) The deletion only targets at the contents of memory. Once user did not click Save, the
software would restore the deleted content while it was restarted.

3. Support modification of single “Map Key”

(1) When “Map Key” works as unique key, modification is not supported, nor the record option
modification.

(2) User can modify name and description of “Map Key” as well as re-record workflow of
command. However, the command workflow supports re-recording instead of fragment
modification.

(3) All modification works only after clicking OK; The button of Cancel can restore the contents
prior to modification, and even the re-recording flow can be restored.
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% Record Script & 22 || % Script Record I &
—Map K
PReY Key Hame -~
| Test Test
—Mame '

—Description

o) T »

~Description

—Record Options
@ Manually finish,
() Auto finish after all required options are set,

= ) 1] B

swe | [ clo

4. Support save all current “Map Key”

(1) All “Map Key” in the current panel will be saved in a configuration file.

(2) Initialize the function of “Map Key” when the software restarts, and pre-load all “Map Key” in
configuration file into memory, aiming to support fast trigger of “Map Key”.

(3) Only after clicking Save can all modification be read-in configuration file and actually
complete backup. Otherwise, all “Map Key” modification will lose when user closes the software.
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¥ 7wiD e

@ "Save" was successful.

=>Whereitis

Menus >> Utilities >> Script Record

1.2 Equation Manager

1.2.1 External Excel Association and Drive Updates Support
In equation manager, newly support external Excel association and drive updates. User can import

external Excel to equation manager and associate with it. When user modifies the content in Excel, the

associated content in equation manager will be synchronously updated. The button Y enables user
to break the association between equation and Excel. The associated expressions have link icons as below

shown.
¥ Equation Manager =2 =
~ Expression List
Filter All v A or\Desktop\Equationxlsx = & @ {3
MName Expression ‘Value ‘ Unit ‘Type
v a5 Part043
i a 100 100 mm Number
b 150 150 mm Number
e 200 200 mm Number
=>Where it is

Part Environment >> Tools >> Insert >> Equation Manager

1.2.2 Equation Manager Improvement

Equation manager extends the physical quantity types and their unit types as well as 2 physical quantities
including pressure temperature and their corresponding units.
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Pressure Unit:
Pa
kPa
MPa
psi
bars
atm
mmH20
mmHg
inH20
inHg
mN/mmA~2
N/mm~2
N/cmA2
N/dmA2
N/m~2
Ibf/in”2
Ibf/ftA2
kgf/mmA2
kgf/cm”2
kgf/dmn2
kgf/mA2
at
Temperature Unit:
Celsius
Fahrenheit
Kelvin
Rankine

=>Whereitis

Part Environment >> Tools >> Insert >> Equation Manager

1.3 Crash Report Improvement

Adapt to high resolution screen. With the improvement, the error report interface supports high
resolution screen as well as normally identifies user’s operational system information. Newly add CPU
information. The computer information will be sent along with sending error report. The interfaces of
application CrashReport and Manager have been merged to one application ZW3DCrashReport.exe .
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¥¥ 7W3D Error Report et

' '
We are SOrry IEIZII’ t].'I.E 1nCONYenl ence.

IW3D. EXE has encountered a problem and nmeeds to close. @

Tou may try to save wour changes, 1f the application i1s still
responsive.

We have created an error report that wou can send to us. We will
treat thiz report az confidential and anomomous.

To help us diagnose the canse of this error and improve this
zoftware, pleaze deseribe what vou were doing when this error

ogourred, and send this report to us.

Dezcribe what wou were doing when the error ocourred I:-:-pti-:-nsl].:l:

The contents sending now may contain the information of the drawing
being manipulated.

Click here to =elect contains to send.

Don' t Send | ISend Error Report
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2 Converter

2.1 Import Format Update

The following table shows the import format supported by ZW3D, and the newly update formats are
marked in RED.

Catia V4 .model, .exp, .session 419-4.2.4

Catia V5/V6 .CATPart, .CATProduct, CATDrawing, .CGR, .3DXML V5R8---V5/V6R2020
NX(UG) prt 11— NX 1899
Creo(Pro/E) .prt, .prt*, .asm, .asm.* 16 — Creo 6.0
SolidWorks .sldprt, .sldasm 98— 2020(Only 64 bit supported)
SolidWorks_2D . slddrw 2013-2020(Only 64 bit supported)
SolidEdge .par, .asm, .psm V18 — SE2020
Inventor .ipt, .iam V6 -V2020

ACIS .sat, .sab, .asat, .asab R1-20201.0

DWG .dwg R11-2013

DXF .dxf R11-2013

IGES .ige, .iges

STEP .stp, .step, .stpz 203, 214, 242
Parasolid X_t, .Xx_b, .xmt_txt, .xmt_bin Up to 30.0

VDA .vda

Image File * bmp, *.gif, *.jpg, *.jpeg, *.tif, *.tiff

Neutral File *.z3n, *.v3n

PartSolutions * ps2, *.ps3

STL * stl

3DXML .3dxml 4.0-43

XCGM X cgm R2012-2020 1.0

T gt 6.4-10.4

OBJ .obj
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2.2 % Adjustment to “Quick Import”

Optimize the file import efficiency of large 3™ format file. Increase the import efficiency from the
following two aspects and optimize user’s experience.

1) Introduce much more parallel mechanism to speed up the assembly drawing import.

2) Process import flow in the platform and optimize import flow.

The modified of import flow are as follows:

2.2.1 Adjustment to “Quick Import” Ul

The new “Quick Import” cancels the limitation to user setting import mode. User can set some hidden
component, suppressed component and free point, etc.
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¥¥ CATIAS File Import = R

CATIAS

¥ Import from

File | C:\Users\Administrator,Desktoph__093.CATPart o

¥ Import to

@) Current Object

) Mew Object

) New File

¥ General

Repair gap [¥] Auto activate part

Auto create sub-part Import geometry set as layer
Buto save files as full shatter Associative import

Import mode Meormal v

¥ Read

[¥] Free curve

[¥] Free point

[¥| Hidden component

[¥] Sheet body

[+] Hidden entities
Suppressed component

[+ PMI

Default Ok Cancel

2.2.2 Add Import Feature Node to “Quick Import”

1) Each part created by “Quick Import” will generate a history feature node. As for assembly import,
multiple history feature nodes will be created. Each history feature node is only associated with
display data of the current part. If it is an assembly node, then the display data of its history feature
node is that the geometrics of the assembly node.

10
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2) Each history feature node records the contents including the imported optional setting, and the 3™
format drawing path info that is corresponding to the current imported part.

3) User can redefine the history node created by “Quick Import” and can re-select the path of 3 format
drawing while re-defining. According to the re-selected path, if the path is different as before, the
display data associated with the history feature node will be firstly cleaned, and then quickly re-
import the display data under the new path. If an assembly drawing is selected, only its geometrics
display data will be quickly imported.

4) Inregeneration, use the current display data and it will not regenerate display data according to the
history node generated by “Quick Import” but skip the node directly.

5) Require adding a feather tag to the history feature node generated by “Quick Import”. History
regeneration will not be triggered by dragging the lightweight feature node.

6) The history node generated by “Quick Import” will increase “Load Model” command. If the
corresponding 3™ format file of the history node does not exist, it will delete the display data of the
history node accordingly. Meanwhile, load the corresponding geometrics data of the 3™ format and
convert the current history node to general static data node. If the 3™ format file does not exist, then
give a tip to user that the corresponding file cannot be found and terminate the loading model.

2.2.3 2" Import Action in “Quick Import” (Import Real Geometric Data)

After “Quick Import”, what we get is only the display data not the real geometric data. Thus, after that,
we need to import the real geometric data. Such 2" import action may happen in the following scenarios:

1) User requires initiatively to “Load Current Model” or “Load All Models”.

2) When user activates the corresponding part, prompt the user to load the real geometric data or not.
If the user selects Yes, then load the real geometric data.

2.2.4 Remove “Quick View”

Since the new “Quick Import” function is basically the same as the current "Quick View" function when
it is imported for the first time, the "Quick View" function is completely abandoned, and the relevant
options and command entries will be removed.

=>Whereitis

File >> Import >> Quick Import

11
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2.3 Y Convert Attributes Support

Support reading-in the user custom attribute of part while importing and reading-in the part attribute as
well as hidden components, suppressed components, hidden entities, user custom attributes and material
density. Formats and read functions are as below:

Format Hidden Suppressed Hidden User Custom  Material
Components Components Entities Attributes(1) Density(2)

NX

Creo

SolidWorks

CatiaV5

Inventor

Solid Edge

Remark: X means unable to be read; Vv means able to be read.

(1). User custom attributes are only captured on the part, assembly, and component instead of the layer
of part internal shape.

(2). At present mater density can only acquire the material name and its corresponding density.

(3). NX user custom attribute name contains two parts: Category and Title. After converting ZW3D user
customer attribute, the attribute name shall be Category|Title

(4). Catia V5 supports acquiring the user custom attributes of assembly or sub-assembly (such as part
number and version and so on), but the user custom attributes of component is not supported (such as
instance name and so on).

(5). Inventor has limits to support the following user custom attributes: Support the attributes in the
options of Custom, Project and Status but excluding File Status of Status.

(6). SolidEdge supports user custom attributes started from ST4 while it is not supported in the older
versions.

(7). Solidworks has limits to support user custom attributes import. The information under Summary
option cannot be imported to ZW3D.

=>Whereitis

File >> Import

12
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2.4 Other Adjustment

2.4.1 DWG/DXF Export Add "Explode hatch as single line" Option

In 2D engineering environment, while exporting DWG/DXF format, section line is exported as the type
of pattern fill block. After checking the option of "Explode hatch as single line", the section line will be
exported to DWG/DXEF file as the type of single line.

¥ DWG/DXF File Generation =
DWG/DXF | Filter

¥ Export to

File Ci\Users\Administrator,Documents\ZW3Dh_0932_2D.dwg |

¥ General

File type @ DWG () DXF(ASCI) () DXF(Binary)

Version 203 T

¥ Optional

Options Tolerance
[¥] Reduce data UV Curve 0.01
[+7] Trim surface
Free surface HII
Merge arc Surface 0.01

0.01

¥ Color

@ True color ) Index color

¥ Drawing

@ Export active sheet only () Export all sheets
@ Exportto model space () Export to layout space

[¥] Export sheet format entities

Drawing view
@ Export as curves () Export as block
() Export as block for each component

[] Export to new layer for each part

Scale output 1:1 Default 11

Rermove text font info type MNone 2

||E| Explode hatch as single line |

Default 0K Cancel

13
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2.4.2 DWG/DXF Import Add “Placement” Field

While import DWG/DXF format to current object and current object is a part, add “Placement” field. The
drop-down list of “Placement” allows you to select all CSYS under current object. After importing, the
origin of the model aligns with the origin of the selected CSYS.

¥%¥ DXF DWG Import Options o
DWG/TKF Filter
» Import from
¥ Import to
Import to Target
@ Current object Part
) Mew object
. i Sheet
) Mew file
Placement Default Csvs - || O <t<h
¥ General
[¥] Auto sew geometry [¥] Auto activate part
Auto create sub-part Convert polylines into curves
[ ] Refine polyline curves [¥| Read empty layers
Convert polygon mesh to 5TL blocks L7
¥ Unit
File units ZW3D units
Q) Usefileunits —
. Millimeters Conwvert to  Millimeters
() Read as
¥ Read
[+ Model space
[| Paper space
4| i | »
Default oK Cancel

14
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3.1 Sketch Design

3.1.1 Improvement of “Conflicting Constraints Check”

In sketch environment, when a conflict occurs to constraint/dimension, all conflicting constraints and
dimensions will list in Conflicting Constraints Manager where user can delete constraints/dimensions or
convert dimensions to reference dimensions. Newly add the pull-down list to filter display content,
including Show dimensions only, Show constraints only and Show all.

123.04
@ Conflicting Constraints Manager B ER

—Conflicting constraints

|Dimension: Sketch1_d4 (376) |
Dimension: Sketch1_d3 (342)

Dimension: Sketch1_d1 (283)

constraint type: Perpendicular (363)

constraint type: Parallel (245)

constraint type: Parallel (241)

—— constraint type: Perpendicular (237)

constraint type: Horizontal (233)

o). 00°

[¥] Auto pop up conflicting constraints and dimensions

|
|
|
|
|
|
|
b * Show all L

Delete Dim-»Ref

I 123M 1

=>Where it is
Sketch Environment >> Constraint >> Conflicting Constraints

Configuration >> 2D >> Sketch >> Enable constraint conflicting manager

3.1.2 % New “Equal Curvature”

In sketch environment, add “Equal Curvature” which can be added onto curve and curve, curve and arg,
curve, and line. The constraint lines need end to end. After constraint, two lines G2 continuity (curvature
equal).

15
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)+ Equal Curvature 3
2 v/ X o
: ¥ Required
Curve | &
Curve &

=>Where it is

Sketch Environment >> Constraint >> Equal Curvature

3.1.3 New Character Spacing in ReadySketch Text

User can adjust the characters spacing through ReadySketch Text to better modify the value between
characters spacing.

-4 ReadySketch Text E3
v X o
¥ Required
Origin 4962.04,5846.64 | ¥ E -
Text ZWSOFT &
¥ Font
Font ZW3D Triplex Roeman v
Style Regular b
Size 20 mm 5| &
Spacing 1 2| &
¥ Settings
Curve @
Mirrar
¥
20
A

=>Whereitis

Sketch Environment >> Drawing >> ReadySketch Text >> Spacing
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3.1.4 Support Relocate Sketch Plane, Sketch Direction and Sketch Origin in
Sketch Editing

In sketch environment, add the function of “Relocate”, by which user can relocate sketch in the process
of sketch editing and does not need to exit from sketch at first.

J= Relocate =3

v | X Li]
¥ Required

2

Plane F3
Up |
Origin

Reverse horizontal direction
Use centroid defined by Plane

4

€«
& |&o

4

=>Whereitis

Sketch Environment >> Setting >> Relocate

3.1.5 YNew Cosmetic Sketch

In 3D sketch environment, newly add the function of “Cosmetic Sketch”, by which user can add some
symbols or graphic tags in part environment or draw some geometric figures onto other feature or
model (such as logo).

17
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Three characteristics of “Cosmetic Sketch”:

1) Annotation: The sketch is an annotative sketch, which means it cannot be used in the features
of modeling.

2) Hatch pattern: After exiting “Cosmetic Sketch”, user can add hatch pattern in closed area in
“Cosmetic Sketch”.

3) Projected: The cosmetic sketch can be projected to the surface of entities and engineering
drawings.

=>Whereitis

Part Environment >> Shape >> Basic Shape >> Cosmetic Sketch

3.1.6 Display tinted closed ring

1) Display tinted closed ring. During drawing, the general sketch can hatch closed area in entity
(pure color).

[ . ]
2
ot
A1 + £
J_ —
[ -
iz

2) Closed area check. Prompt the user that exist nonstandard geometries to check closure when
he or she exits sketch in creating a sketch with modeling command.

%P 7W3D X

® There exists nonstandard gecmetries. Do you want to continue?

18
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=>Whereitis

Sketch Environment >> DA Toolbars >> Closed Rings On/Off

3.1.7 New “2D Sketch Offset Constrain”

When the command is executing by sketch, add offset constraint by default. Analyst geometrics like line,
circle/arc, polyline, and rectangle and so on are supported. Display offset constraint icon and offset
distance dimensions between the original geometry and the offset geometry. Use can modify offset
distance through dimensions as well as delete offset constraints and dimensions.

=>Whereitis

Sketch >> Curve >> Offset

3.1.8 New Option of “Hide used sketch”

Newly add the option of “Hide used sketch” to control whether the used sketch will be automatically
hidden.

=>Whereitis

Configuration >> Display >> Toggle settings >> Hide used sketch
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3.2 Wireframe Design

3.2.1 Improvement of “Project Curve”

Two mayor improvements of “Project Curve” include:

1) Break prior to project to curve and clean overlap after project to curve.

2) Solve failed situation of project to curve.
a) When the direction is not defined, the circle cannot be projected to sphere.
b) Issues related to project to seam edge.

c) Incorrect results of 2D sketch reference and offset.

3.2.2 Improvement of “Curve Modify” Align Type

Newly add 6 “Curve Modify” align types, including Auto Plan, Plane, WCS, View, Tangent and Normal as
follow:

Auto Plane: auto search the least square plane of control point in curve, and the control point moves in
the plane.

Plane: use custom defines input plane where the control point can move.
WCS: no limitation to the control point which can move to any point.
View: the control point can move in the current view.

Tangent: the control point moves upwards to the selected tangent line.

Normal: the control point moves upwards to the selected normal line.
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U Modify 53
v X E @ P
¥ Required
Curve @
Point @
¢ Constraints
Align type Plane |T|
Auto plane
Algn plane ErT—
i ) WCSs
=
Lze orientation tool View
. Tangent
¥ Modification Mormal

=>Whereitis

Part Environment >> Wireframe >> Edit Curve >> Modify

3.3 Part Design
3.3.1 % Modeling Dimensional Accuracy Update
The minimum modeling accuracy is supported from 0.0001mm to 0.00001mm.

It is suggested that the maximum model accuracy is no more than modeling accuracy*10e+9 while the
minimum feature dimension is no less than modeling accuracy *10e-5.

3.3.2 % Complete CSYS Support

Compose a complete Cartesian coordinate system, including Datum axis, Datum plane, Datum CSYS,
Datum axis 2D and add features in history according to the created timing sequence (sketch axis excluded).
The platform has only one local coordinate system (LCS) which is default as modeling reference system
with globally invariant world coordinate system (WCS) as its default value.

Replace XY, YZ, ZX features on history tree with a value of WCS Datum CSYS feature. It is only a general
Datum CSYS feature and does not present WCS or LCS. And it can also be redefined.
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3.3.2.1 Datum Axis

Datum axis only contains one orientation and defines origin and length. The datum axis command panel
shows as below:

/" Datum Axis 53
v X E Ll
¥ Required
1 A
Vb |22 |-
Geometry | v & -
Length 9.6 mm o v

¥ Orientation

Flip direction

¥ Datum Attributes

Custom attributes

Color

Style _— &
Width &
Datumn format Arrow -

Datum axis format includes Arrow and Line which can be set color, style and width.

Datum axis has the following characteristics:

1. Independent Entity
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Datum axis is an independent entity and there is a single feature node in history tree. Support common
editing operations, including pattern, mirror, move and copy. It can be managed in layer manager and
has corresponding filter type DatumAxis.

2. Orientation Input

Execute such as Extrude, Pattern and Project Curves. As for the commands of vector\direction input in
the platform, the option of Datum Axis is added to filter with only allowing to select Datum axis object,
Datum plane object Z axis and Datum CSYS object has three datum axes. When the filter is Edge/Curve,
disallow to select all the above-mentioned objects.

3. Dimension PMI
Support Quick Dimension. Linear. Angular. Symmetry.

g A

Quick Linear Symmetry Angular
Dimension

4. Assembly Constraints
1) Insert command: snap axis origin; coincide component origin and axis origin; component Z axis
orientation is identical with datum axis orientation.

2) Common constraint: parallel, vertical, angle, coincident.

=>Whereitis

Part Environment >> Shape >> Datum >> Datum Axis

3.3.2.2 Datum axis 2D (Sketch)

The command panel is as follows: If “Construction geometry” is checked, create only internal axis to use;
otherwise, create external axis to use and work as sketch’s revolution axis by default.

23



.\
S
.
[T
N
...

Istpoint  -60,-15 v &-
ndpoint  -35,20 v &-
¥ Settings

Display guides

Construction geometry

2D datum axis is an infinite hidden line. The internal axis shares the same display attributes with the
general constructive line as grey hidden line. The external axis is brown hidden line. Use can switch the
internal and external axis through Toggle External/Internal.

- A

- \

Show Constraints
Cut

Copy

Erase Entities
Blank

Show Only

Entity Info

Customize menu

2D Datum axis has the following characteristics:
1. Default XY

Sketch contains two XY objects by default, infinitely long, and default XY cannot be modified or
deleted.
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2. Independent Entity

Support common editing operations, including Pattern, Mirror, Move, Copy and Revolve.

3. Constraint
Support 2D line constraint (excluding equal length and point to center).

Constraint | Teoeols  Inguire

x| S & Q

D=l
¥ | Horzontal Auto She
Constrain Const

4

HORZ | Horizontal

ks Vertical

s f
Symmetrical

_L Perpendicular
// Parallel
.‘/ Collinear

Q Tangent

"=" Equal Length

Point to Center

4. Dimensions

Support 2D line dimensions.

5. Revolve axis
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’

_ ——
IZI o IEI <LEFT-CLICK> TO ACTIVATE DYMNAMIC PICK INPUT. k- ¢

¥ Required

Profile P Sketch @ &

Axis A 0.52635,0.85027,0 ¥y &-

Revolvetype 2 sides -

Startangle S 0 deg > &~
End angle E ez deg 5 |® -
¥ Boolean

@ o =
Boolean shapes | 7
P Offset
¥ Settings

A

[ Flip face direction

¥ Tolerance

Tolerance |U.01 mm

=>Whereitis

Sketch Environment >> Sketch >> Drawing >> Axis

3.3.2.3 Datum CSYS

Datum CSYS is composed of origin, three X/Y/Z datum axes, and three datum planes. The origin is
something like a dot entity that plays as dot capture reference. The three datum axes can be treated as
an independent entity that used as general orientation reference. The three datum planes can be used as
a general plane. The coordinate system can be regarded as an independent entity.

The command panel goes as below:
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L Datum C5Y5 £2
v[X = o
¥ Required
1 A K -
P« U # N
wH e § P
Geometry | | &
¥ Orientation
¥ |-z
< § ¥
H Y :
Offset 0 mm S| & -
Origin ¥ &~
X point ¥ &~
X angle 0 deg o 0~
¥ angle 0 deg o & -
Z angle 1] deg 5 0~
¥ Datum Attributes
Custom attributes
Color
Style e he
Width — b
Datum format Default -

Three datum axes, three datum planes and one origin are drawn in the drawing area. Each datum axis is
marked as its name (X, Y, Z). The coordinate system works as a whole selection by default, and its default
color is brown, which shows as below:

The datum CSYS has the following characteristics:
1. Asanindependent entity

Datum CSYS exists as an independent object and corresponds to an independent modeling history tree,
which can be executed by common edit commands such as Pattern, Mirror, Move and Copy. There exits
corresponding Datum CSYS filter object. It can be treated as an independent object as well as managed
by layer manager. Besides, it has unique attributes such as visibility, color and line thickness, etc.
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2.  Component members

It is composed by origin, X/Y/Z datum axes and three datum planes.

3. Constraints
The coordinate system aligns with CSYS.
=>Where it is
Part Environment >> Shape >> Datum >> Datum CSYS

Newly add option “CSYS” in Default datums of Configuration and set “CSYS” as default datum. After
setting, the default “CSYS” is created when a new part is created. Keep the original “Triad” option, you
can still switch to the old “Triad” mode through this option.

Default datums Top |T|
M

Default part filter setting Toc;}ne

[¥] Allow dynamic drag of ass Front
Right

Ignore constraint failure di Triad

|1 TR - S A C5Y5

=>Whereitis

Configuration >> Part >> General >> Default datums

3.3.3 New Method to Create Datum Plane

Create a datum plane with 2 entities. Newly add the two following entities to select.

1) Select arc surface and datum plane to create plane.
2) Select datum plane and line to create plane.
=>Where it is

Part Environment >> Shape >> Datum >> Datum Plane >> 2 Entities

3.3.4 Geometries Direct Cross File Copy via "Ctrl+C/Ctrl+V" Support

Newly add hotkey "Ctrl+C/Ctrl+V" to copy geometries (Curves, Surface, Entity). The copied geometries will
be pasted as static ones.
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3.3.5 YNew Cross-section Type “G2 Blend” in Fillet Command

Rename "Arc Type" label to "Cross Section Type" and add "G2 Blend" option to the drop down list.
When the "G2 Blend" option is selected, a pair of "Start/End Weight Sliders" will be displayed for
further cross section shape control.

& Fillet £3
v X E F @Rk
¥ Required =l
TVIV
EdgesE | | ¥
Radius R 5 mm o & -
¥ Variable Radius
Haold line o
Vanable radius
Add Madify Delete _
Wertex ﬁ
Exception &
¥ Shape of Fillet
Relief 0 mm > D
Cross-section type G2 Blend v
Start weight 1000 2|~ ———
End weight 1000 2|~ ———

# Rollover Control

P Settings

=>Whereitis

Part Environment >> Shape >> Engineering Feature >> Fillet >> Shape of Fillet
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3.4 Free Form Design

3.4.1 New “Cross Trim”

Add a new command Cross Trim in Free Form Ribbon, by which user can decide which side to keep when
to select more than two sheets or faces and select whether to automatically sew the remaining or not.

e Cross Trim =2

| v X o
W i ¥ Required

Entities 2 picked K

©) Facestoremove () Facesto keep

Regions 2 picked ¥ &~

] ¥ Settings

Sew shapes

¥ Tolerance

Tolerance 0.01 mm o

-

=>Whereitis

Part Environment>> Free Form >> Edit Face >> Cross Trim

3.4.2 %"Blend Face" Command New Option "G2 Blend"

Renamed "Arc Type" label to "Cross Section Type" and added "G2 Blend" option to the drop down list.
When the "G2 Blend" option is selected, a pair of "Start/End Weight Sliders" will be displayed for
further cross section shape control.
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w* Blend Face 23
v X E @ P
¥ Required

From III @
Ta I:I &
Through I:I &
¥ Orientation

Spine Matural =

¥ Shape of Blend

Cross-section type G2 Blend |T|
. Circular
Start ht
welg Conic

End weight
¥ Sew

Sew shapes

Shapes b2
P Settings

P Auto Reduce

P Tolerance

=>Whereitis

Part Environment >> Free Form >> Basic Face >> Blend Face

3.4.3 % "Fillet Open Faces" command New sub menu "Shape of Fillet"

Added a new sub menu section called "Shape of Fillet", where "Circular", "Conic," and "G2 Blend" cross
section types can now be specified. When the "G2 Blend" option is selected, a pair of "Start/End Weight
Sliders" will be displayed for further cross section shape control. When the "Conic" option is selected,
"Conic Ratio" input is supported.
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#_ Fillet Open Faces 53
v X E Li |
¥ Required

Reverse side

1st face | |I| A
I

2nd face B
Reverse side
Radius 5 mm o & -

¥ Shape of Fillet

Cross-section type Circular |T|
:
¥ Settings Conic ’>
Base faces NGGE Blend

=>Whereitis

Part Environment >> Free Form >> Edit Face >> Fillet Open Faces

3.5 Sheet Metal Design
3.5.1 % New “Zero Radius Flange”

This function aims at supporting zero radius flange, including its construction, modification, folding and
unfolding, and identification import. Add zero radius flange to six commands including Full Flange, Flange
with Profile, Partial Flange, Hem Flange, Fold by Line and Jog. As for the bend radius less than modeling
accuracy, all will convert to zero radius flange.

32



G y
- " \ _ 4

All-in-one, affordable CAD/CAM

’

£ Full Flange
v X E
¥ Required

Edges 1 picked
Flip the flanges

¥ Flange Parameters

Position L L

¥ Bend Attributes

Bend Simple
RadiusR1

Angle 90

ergnee | (|
Length 40

3.5.2 Improvement of “Punch”

Once “Punch” is interacted with punch mental plane, punch will be completed. Support “Punch” to select
face excluded for forming open.

Support external part model as “Punch”. Location is provided to locate related modeling. Related with
source is to control whether there are relations and decides to update punch result as external “Punch”

model updates. Add “Punch” library to the platform standard library, which allows user to build own
“punch” library.

The command panel goes as below:
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< Punch &3

X [0

¥ Required

Base F2 I&
Punch P 52 Ik
Open O 1 picked I:I g
¥ Fillet

Add fillet

Radius 2 mm o 5

* Punch 53

X o0

s

Base P2 L

}-PunchlfiB\punchlfi B test file\22 Z3PRT || €5

11.Z3PRT
22.73PRT
33.Z3PRT
44.73PRT
55.Z3PRT
multi.Z3PRT
PartD01.Z3PRT
Part002.Z3PRT

Location 106784,-22.4128,-30 ¥ & -

Frame @

Related with source

¥ Fillet

Add fillet
Radius 2 mm - B

Part Environment >> Sheet Metal >> Form >> Punch

»
J
J/

All-in-one, affordable CAD/CAM
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3.6 ECAD

Check the option of “One object per file (new files)” in General of Configuration in advance.

=> Whereiitis

Part Environment >> Configuration >> General >> One object per file (new files)

3.6.1 Import IDF File

3.6.1.1 New “Import IDF File”
The import steps go as below: click “File >Import>Import...”, and the following dialogue will pop up
after selecting required file to import. After setting the import options, click “OK” to import IDF file.

¥&# ECAD Import Options L= Y

ECAD Filter

¥ Import from

Board file C\Users\Administrator Desktop\01\TEST.emn &
Library file C:\Users\Administrator\Desktoph01\TEST.emp &l

¥ Input
Default board thickness 0 :
Default component height 0 .
Default hole diameter 0 :

Default 0K Cancel

=>Whereitis

File >> Import >> Import...
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3.6.2 Export IDF File

3.6.2.1 New “Export IDF File in ECAD Environment”
The export steps are as following: click “File>Export>Export...”, and then the following dialogue will
pop up and click “OK” to export IDF file after setting the board file, library file and export version, etc.

IGES File [#. igs;#. iges)

STEF File (% =tp:#%. step)
I¥G/TYF File (% dwg;*. dxf)
FParasclid Text File (% x_t)
Parasolid Binary File (% x_b)
VD& File (* vda

BCIS Files (% zat;#*. =ahb)

STL File (* ztl)

OFT File {* ohj)

VEML File (#. wrl)

Heutral File (*. vxn)

Wentral File (#. z3n)

HIML File {#. html;#. htm)

Bitmap File (. bmp)

GIF Image File (# zif)

JPEG Image File (% jpgi#. jpeg)
FPHz Image File ':*.png§

TIFF Image File (% tif;# tiff)
FIF File (% pdf)

CATIA ¥4 File (% model)

CATIA V& PART Files (% CATPart)
CATIA V5 ASSEMELY Files (% CATProduct)
CGR File (. car)

YO File (% zogm)

SIEML File Ok, 3deml)

JT File (% jt)

IFC File (#. ifc)

Intermediate Data Format (% emm;*. brd)

Intermediate Data Format (% emm;*. brd

J
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¥ ECAD Export Options

ECAD Filter
¥ Export to

B ER

Board file ChUszers\Administrator\Documents\ ZW3DAPartD | ©
Library file Ch\Users\Administrater\Documents\ZW3D\PartDd «

¥ Generation

Export version

Default

IDF 3.0

oK

Cancel

=>Whereitis

File >> Export >> Export...

3.6.2.2 New “Export IDF in Part Environment”
The export steps are as below: click “File>Export>Export...”, and the following dialogue will pop up
and click “OK” or “Apply” to export the corresponding file after settings.
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IGES File (% igs#*. lges)

STEF File [#. stp:#. step) (a8 -
IWG/IXF File (* dwg;*, d_xf:I ‘?— Expﬂl't IDF

Farazolid Text File (% x_t) = |
Farazolid Binary File {*.x_]:-:' ‘V x E ﬂ E
VO& File (% vda

ACIS Files i#*. sat;*. sab) ¥ Reguired

STL File (. stl)

DET File (. obj) Coordinate systern  Default C5Y5 &

VEML File (% wrl)
Heutral File (% vun)

Heutral File (% z3n) Top side F2 &
HIML File= {*.{html;?.htm}

Bitmap File (% bmp : L
GIF Image File {JE gif:l ) Lipieis F1 ﬁ
JPEG Image File (% jpz;*. jpeg .

FHG Image File (% png? ¥ Options

TIFF Image File (% tif;* tiff)

PP Tile Lendf) D) Exportfile  ments\ZW3D\Part070.emn | £
CATIA V5 PART Files (% CATPart) i

CATIA V5 ASSEMELY Files (% CATFroduct) Export version  [DF 3.0 hd
CGE File (% cg:l

XCR File (% xcgm) Output as Board -
SD}EM:IL File II:*.SI:]J{ml:'

JT File (. jt) [ Show export log

IFC File (. ifc)

Intermediate Data Format (4. emn;#. hrd)

Intermediate Data Format (% emm;*. brd -

=>Whereitis

File >> Export >> Export...

3.6.3 New “Create” ECAD Module

3.6.3.1 Create ECAD File
The steps to create an ECAD file are as following: click “File>New”, and then select “ECAD” type
and click “OK” after naming the file.

37



J

All-in-one, affordable CAD/CAM

¥ Create New File L X
Type

D < 2

Part/Assembly Drawing Sheet Standalone Sketch CAM Plan

o

ECAD

Template Information

“DE{EUH] Unigue Mame

Part006.Z3PRT

Description

Cancel

=>» Where it is

File >> New >> ECAD

3.6.3.2 New/Edit Board

~&

Mew/Edit
Click Board s used to create a new PCB model or edit an existing PCB model.

The steps to create are as following: click “New/Edit board”, and then the following dialogue will
pop up. Click “OK” after naming the file.
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¥¥ Create a PBC board LT

Part
BOARD

Descripticn

Cancel

= Whereitis

ECAD Environment >> Assembly >> Component >> New/Edit Board

3.6.3.3 Region Set

Use “Region Set” to set cosmetic sketch as a region with specified attributes, where user can define
“Routing Region”, “Placement Region”, “Via Region”, “Other Region” and “Placement group region”.

“% Region Set ]

X = o

¥ Required

LIV NeDw

ProfileP | |& [w

Lo

¥ Properties
] 3D volume

Height 0 mm > | &
Type Keep-in -
Owner MCAD v
Color | |

e  Routing region: set a closed profile cosmetic sketch as a routing region which can be set to

allow/disallow routing region.

e Placement region: set a closed profile cosmetic sketch as a region that allow/disallow to place.

e Via Region: set a closed profile cosmetic sketch as Via region.

e Otherregion: set a closed profile cosmetic sketch as other region which is namely user custom region.
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e  Placement group region: set closed profile cosmetic sketch as a placement group region.

= Where it is

ECAD Environment >> ECAD Board >> Engineering Feature >> Region Set

3.6.3.4 Region Cut
Use “Region Cut” to create a cut in PCB module. Notice that the selected sketch must be profile

closed.

=>» Whereitis

ECAD Environment >> ECAD Board >> Engineering Feature >Region Cut

49 Region Cut
v X E

¥ Required

Profile P

r 22

Bl t

ko

”

ol

Show Most - || ||Y

&% BOARD
> [ Solid(1)
v €3 History
[ i Default CSYS
> [/] #4 Tab1
] % (-)Sketch2
7] @ cuti
[ — MODEL STOP HERE -----

> Replay
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3.6.3.5 Add Hole Attribute
Use “Add Hole Attribute” to add hole attributes onto PCB model, such as PTH or NPTH.

Add Hole Attribute 3
n v X E i 0

¥ Required

EF_E Hole feature “ ‘ &

¥ Attribute

Plating style PTH T
Owner MCAD T

o] Fa

= Whereitis

ECAD Environment >> ECAD Board >> Engineering Feature >> Add Hole Attributes

3.7 Assembly Design

3.7.1 New “Dissolve Sub-assembly”

Use command “Dissolve sub-assembly” to dissolve sub-assembly and move the component from the
lower level to upper one.

v aa MRS ERE
M@ e @
.E‘i}]t& 4: g
o X

v|[¥] & Parid /-,
8
. {=] 3- Insert Component
(- E Change Component
@i 3 RenamePart

> [ Constrail

Regen

Configure Component

=';- Dissolve Assembly

3.7.2 New “Group as Sub-assembly”

Use command“Group as sub-assembly” to create a sub-assembly with some serverl components, and
also allow to save sub-assembley with new file format or new object.
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v LR R

@ (FinE

@ Zi

@ (-8

L BT

@ (-):E o Auto Regen

™ Configure Component
B Ptk
> 71 Constrair

ﬁ'_=:: Group as Sub—assemblyl

@ Group as Sub-assembly L= Y

File Name  #1.FAEH.Z3

Part Name  |[ZElj0¥]

3.7.3 “Edit Constraint” Support Multi-select Components and Search Mutual
Constraints

Add a new “Edit Constraint” to support multiple components selected and search their mutual
constraints.

& Edit Constraint 3

v | X E LU
¥ Required

1L

Component(s) 2 picked

¥ Constraints

—Constraints

\Coincident & Plane Plane | &
Coincident @ Plane Plane -
Concentric 4 Cylinder Cylinder

=> Where it is

Part Environment >> Assembly >> Constraint >> Edit Constrains
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3.7.4 New “Filter” in Assembly Tree

Add a filter button in search box of manager to control the show result.

Manager B X
_  Show Most M Y

3.7.5 Y% New “Clearance Check”

Provide new assembly search command “Clearance Check” with the following characteristics:
1) Support for searching clearance value between components;

2) Support for searching clearance value between component and shape;

3)  “Clearance Check” result displays in a table;

4) To export “Clearance Check” result in xIsx file is supported.

&9 Clearance Check 2
X = o

¥ Required

Components 2 picked &
Clearance(<) 30 mm & -

Check

¥ Settings

Scope Only among the picked h

Check clearance between component and shape|

[[] Check sub-assembly internal parts clearance
Ignore hidden shapes and components
W aYe

¥ Result

Unrelated components  Hidden i

|Partname1 Part name 2 ‘u’alue(mm]| |

1 i 31000000

Output check results L

4

a4 1 | »

=>Whereitis

Part Environment >> Assembly >> Inquire >> Clearance Check
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Add a new command “Batch Attribute Edit” to provide user to batch edit part attributes. The command
panel goes as below; its left list shows the attributes and values while its right list shows the objects to
edit. User can modify multiple attributes of multiple components at one time.

The left list supports to import via external template, and the command will read the template’s attribute
and value. User can edit template file. Support select a component through Input Format button and take
the component’s attribute value as default value. Support Synchronous modification of attributes like
material, density, part size and stock size, etc.

The right component list supports user to select part and filter to select parts.

¥ Batch Attribute Edit B R
Lead Config D:\Trunk\2500x64\supp\TempIate.zE Pick objects to edit
Include | Attribute Value | D Name
2 Number ZWSoft123 - h prt0072
= Class Part -
= Designer Mark hd
& Cost 1298 A
=] Supplier ZWSoft =
[ Manager Jasen =
= CustomAttributl | User Attrib1 -
Material = [¥] Remain current list
Density kg/m*3 - Mass v |=/1612188062 Target | L
Part size LxWxH Rename picked shapes
Auto calculate Clear listed objects after update
Stock size 198.37%291.64x136.74(mm) Hide listed objects after update
[¥] Aute calculate \:;r
QK Cancel Apply

=>Whereitis

Part Environment >> Tools >> Attributes >> Batch Attribute Edit
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3.7.7 New “Include unplaced component”

The assembly adds the “include unplaced component” command, which is used to insert an unplaced
component in the assembly tree. The command form is as follows:

“? Include Unplaced Component £3
v X E L

¥ Required

—File/Part

Part079.73 v || -

O

All =

Preview Off hd

Part config 5

¥ Settings

Insert to layer  Active layer b

Unplaced components will be displayed on the assembly tree with the unique icon of unplaced
components (as shown in Part079 in the following figure). Because the components are not placed, the
unplaced components will not be displayed in the graphics window. Unplaced components can be
included or excluded when creating a bill of material and are not accounted for in physical properties
calculations. You can select the unplaced components on the assembly tree and convert them to general
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components through the right-click menu “Insert Component”. After the components is converted to
general components, it cannot be converted back to unplaced components.

Manager .
& || Show All . —
(m|
" v Z Partor9
W (—)Qilcealn |
s & (-)C € OpenPart
; Insert Component
E E‘ Change Component

=>Whereitis

Part Environment >> Assembly >> Component >> Include Unplaced Component

3.8 Drafting Design
3.8.1 Variable Input in Engineering Drawing Show Label Support

Add a new variable input in engineering drawing show label.
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¥ View Attributes L2 2
Style <From Standard > =
General Label Lines Text Comp

& K2 &2 IH
g D |8 = /
v ke = }E +\

Inherit PP \
Show scale

Scale type Use custom scale 7
(= A 1 s : 2 =
O XK. X 0.5 -
Synchronize sheet scale

Show label

Label TOP =

Get variableh
All Off Teggle All On
Layer LayerD000 -
F QK Cancel Apply
—>Where

Drawing Sheet Environment >> View Attributes >> Label >> Get Variable

3.8.2 % New “Point Table” and “Dimension Table”

Point Table: a table that user can extract point coordinate. It is used to tag the selected coordinate value
through table, like BOM or hole table. Bubble tag, table split, and table are supported.

The point list has the following characteristics:

1) The input objects in point list are 3D coordinate points and non-sketch points in engineering
drawing.
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Extracting points in both 2D and 3D coordinates is supported.

When the selected point contains point of view, default 3D coordinate origin as reference point.
When the selected point does not contain point of view, default 2D drawing origin as reference point.

When the selected point contains point of view, the reference point and point of view will move as
view moves; otherwise, it will not.

When the point list contains different point of view, the default reference point will generate order
according to view in priority.

Be similar with BOM or hole table. Bubble tag, split table and table style are supported.
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= Annotation X
v|X| L1
¥ Required
Pointlist || | ¥
Base point ¥ &~
MName
¥ Item Numbers
© StartingID 1 E -
() Starting label 5
Regenerate IDs after sort
[| Show origin indicator
¥ Table Format
Columns Label
Available Selected
Point 3D I}
Point 20
Remarks
4
4
rs
w
Attributes ... Default
Sort by D - 21
[7] Sort when regenerating
Bl s stem defined [ User defined

Dimension table: mark number and list table to the dimensions in drawing according to order.
The dimension table has the following characteristics:

1) Dimensions in table contain all dimension content, including symbols such as radius R, angle °,
thread M and depth, etc. It is not only a number.

2) Dimension id will move as view and dimension move.

3) Dimension is associative with table. When the dimensions change, the table will update as along.
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When one dimension is lost, the dimensions will change in red and the corresponding row in the

table will remain.

=>Whereitis

= Annotation =2

X o

¥ Required

L4

Dimension list |

MName

¥ ltem Numbers

&
1

© StartingID 1 :
() Starting label 1,
Regenerate IDs after sort

¥ Table Format

Columns Label

Awailable Selected

D
Yalue
’ Remarks

4

r s
v

Attributes ... Default
Sort by o B

ort when regeneratin
Sort when reg ing
Bl 5 stem defined 0 User defined

Drawing Sheet Environment >> Layout >> Table >> Annotation
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3.8.3 New Insert “OLE Object”

Add a new “OLE Object” to drafting environment and support insert “OLE” object to drafting.

=>Whereitis

Drawing Sheet Environment >> Dimension >> Symbol >> OLE Object

3.8.4 New 2D BOM Default Template Setting in Configuration

Add a 2D BOM default template setting in configuration and configure 2D BOM template through this
filed. Default create this template when to create 2D BOM.

¥ Configuration R
B = - FY
General Internet browser iexplore.exe
Part ZW3D file folder ChlUsers\Administrator\Documents\ZW3D
0 Working folder ChUsers\Administrator\Documents\ZW3D
Col ZW3D backup folder ChUsers\Adrministrator,Docurments\ ZW3D_
olor
Save backup files in the same location as the original
Background —
Standard parts folder
Display [¥] Create instance in working file | C:\Users\Administrator\Documents\ZW3D\5
Files Punch library EA2500_x64
CAM Symbol library
User Clipboard library
oD [¥] Session journal ninistrator\AppData\Reaming ZWSOFTVIW3 =
Export folder
ECAD
Quick rollback cache folder Chlsers\Administrater\Documents\ZW3D4_
Drafting
Paper size definitions DEF_SHEET_MM
BOM template }
b
4 I | 3
Reset Default Cancel Apply

=>Whereitis

Configuration >> Files >> Drafting >> BOM template
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3.9 ZWMold
3.9.1 “Trim Pin” Support to Select Multiple Components as Trim Body

Add a new “Trim Pin” to support select multiple parts as trim body.

=>Whereitis

Part Environment >> Mold >> Library >> Trim Pin
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4 CAM

4.1 Y Enhancements of Full Machine Simulation

1. Support Machine Builder

The Machine Builder is used to construct the machine tool movement chain and components, edit
the chain properties and other machine tool parameters. The entrance of the machine builder is in
the FMS toolbar.

£5 ZWFMS - Dy/Distribute/2500 x64/languages/en US/resource/machine library/5x table C on A/5X table C on Amch - o X

File View Inquire Help

D&SE @ @ 2d2%a 8
Machine Tree LES
£ 5x_table C_on_A
£ Mahcine_Base
) Machine_Base

=Y
¥ Slide
X

= AL
@ Z Slide
W) Toolhead
= GA
A Table_Solid

) C_Table Solid
& Workpiece
Machine Tree | Pick Info
Properties
Properties Name

Description

Assembly Type Workpiece

Qrigin 0.000, 0.000, -87.900

X-axis 1.000, 0.000, 0.000

Z-axis 0.000, 0.000, 1.000

Axes
GC 0.000 -360.000 360.000
7 X 0.000 -360.000 360.000
e 0.000 -450.000 119.000
7L 0.000 -550.000 550.000

2. New FMS Setting Functionality

The FMS Setting dialog is used to set the Part, Stock, Machine and CNC controller what will be used
for simulation.
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% FMS Setting 0 =

- Work_Assembly
Stock Part001_Stock.1

Target Part Part001

~Machine

Machine 5x table C on A

~CNC Controller

Controller ZW _Fanuc_Mill

OK Cancel

3. New Fanuc CNC Controller

New the Fanuc CNC controller to interpret the NC file which output from Fanuc post processor. The
current version only supports Fanuc controller.

4. Support RTCP Functionality

In ZW3D 2021, we support the RTCP functionality in FMS, if the real machine tool has RTCP function,
please turn on the RTCP option in FMS during simulation. If the real machine tool does not have
RTCP function, please turn off the RTCP option and configure the .znc file for machine simulation.

&l Setting X

Simulation options

[] stop on clash

[[] Stop on first clash
D Stop on gouge

[] Stop on axis limit
D Stop on tool change

Analysis Setting

|
[ |
|

Background

Dark Purple [ | Light Purple [ ] Light Blue [ ] Light Grey

5X Control

RTCP
0K Cancel
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5. New Machine Register Functionality

Machine Register is used to set the coordinates of G54~G59 and the parameters of tool
compensation.

| Machine Tool Register X

Tool Compensation

i) H Value | D Value

1 0.000 5
2 0.000 10
3 10 15
Work Coordinate System

Name X Y A
G54 0.000 0.000 62.1
G55 0.000 0.000 0.000
G56 0.000 0.000 0.000
G57 0.000 0.000 0.000
G58 0.000 0.000 0.000
G59 0.000 0.000 0.000

6. New Measurement tool

New Measure Distance, Show Coordinate and Inquire Arc Data these tools, easy to measure the
model size and location in FMS.
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! Measure Distance ~ — ] X

ist Point [1090. 063, 271. 118, 1373. 790 |

2nd Point [1035. 000, 129. 569, 383. 523 |

Distance |1001.848 [mm] 1
Dist-X 55.063 [mm] ! Inquire Arc Data — O )
Dist-¥  |141.550 [mm]
Dist-Z  |990. 268 [mm]

1st Point ‘1035. 000, 147. 839, 1237. 617

2nd Point ‘1035. 000, 266. 741, 413. 932

3rd Point ‘1035. 000, -261. 831, 325. 557

Radius  [500.049 [mm]

Diameter [1000.098 [mm]

Angle  [177.442 [deg]

Center  |(1035. 000, —67. 168, 786. 161)

Normal |(-L.000,-0. 000, 0. 000)

=] Show Coordinate — O X

Coordinate[(919. 700,-207. 798, 1199. 403)] |

7. Support the Tool Compensation Function

FMS can simulate the tool path with tool compensation, user needs to set related parameters in the
Machine Register.

NC Program [ -]
= Frevious Page : /1 ‘= Next Fage
£ Machine Tool Register *
Status Line NC ~
% Toal Compensation
1 N1 G40 G17 G94 649 G90 G21 G54 S 1 N[ 153 el
il |0.000 5000
2 N2 G91 G28 Z0.0
3 N3 G28 X0.0 Y0.0
4 N4 GO0 AQO C0.0 y
5 NS T1 M08 t .
-/ 6 N6 S1000 MO3 Q/ Add Remave

v N7 M08 Work Coordinate System
& N8 G20 GO0 X-22.5 ¥-40.5 Nane x ¥ z A
9 N9 G43 7100, H1 G54 0,000 0000 -67.900
0 N10 2225 { 0.000 0000 0000

1220, F50. 56 0,000 0000 0000

[ 0.000 0.000 0000
3%-29. annn nnaa nnan ¥
14 N14 Y29, F250.
oK Caneel

15 N15 X29.

8. New the Simulation Speed Functionality

Simulation Speed functionality is used to control the simulation speed, the right side of the control
bar speeds up the simulation.

QKb Pl 0
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9. Support the Display of NC Code and External NC Code Simulation

The newest FMS can display the NC code directly, but not show the .tp code as ZW3D 2020. And
user can also input the NC code to simulation.

NC Program n
= Previous Page N&/2 ¥ Next Page
Status Line NC ~

1 N1 G40 G17 G94 G49 G0 G21 G54
2 N2 G91 G28 70.0

3 N3 G28 X0.0 Y0.0
4 N4 G90 A0.0 C0.0
5 N5 T22 M06

6 N6 S1000 M03

7 N7 MO7

8 N8 G43 G90 GO0 X-26.9713 Y-165.9481 Z51.2056 A-91.5248 C165.548 H22
9 N9 X-2.0234 Y-69.1467 Z53.8667

10 N10 GO1 X-.776 Y-64.3066 Z53.9998 F50.

mn N11 X-3.6782 Y-63.5555 753.8853

12 N12 X-5.4191 Y-63.1049 Z53.8166 A-90.6394 C165.5139 F250.
13 N13 X-7.4672 Y-62.5749 Z53.7356 A-89.5972 C165.4736

14 N14 X-8.7791 Y-62.2353 753.6823 A-88.9297 C165.4482

15 N15 X-8.7793 Y-62.2352

16 N16 X-9.2073 Y-62.1214 Z53.6649 A-88.7228 C165.2671

17 N17 X-9.6785 Y-61.9962 753.6429 A-88.4952 C165.0688

18 N18 X-10.7443 Y-61.7128 Z53.5932 A-87.9805 C164.6203

19 N19 X-10.7459 Y-61.7124 A-87.9793 C164.6197

10. Encrypted the .Job, .Mch, .Ctl, .Wkp, .Tls files.

4.2 %The Rough Turning Operation Supports Arbitrary Contour as
Stock

1. Support the Stock Type of Profile as the Stock to generate tool path

2020 2021
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AT

~ @ Operations

v 3 Rough Turn 1

Tool : Tool 1
~ & Features

W profile 1
& Stock : profile 2

, Machine (undefined)

E Output

00 X

~rTa
¥ @ Operations
~ ## +f Rough Tum 1
Tool : Tool 1
~ @ Features
& profile 1
| @ stock: profile2 |
3 Machine {undefined)
B output

2. Support the Stock Type of Workpiece to generate tool path

2020

Stock : Part002 Stock.1 (2) < Stack Salf
& Port : Part002 (1) < Part002.23
3 Machine (undefined]
B outpat

2021

¥ p + Rough Tum 2
Tool :Toal 2
v @festures
@ Stock | Parti02_Stock.1 (2) < Stock_Soli
B Pat : Part002 (1) < Part002.23
3 Machine lundefined)
Bl output

4.3 New Arc Fitting Functionality in 2X Operation

2X operations added the Fit Arc option; the generated tool path will be as close to the arc as possible

according to the parameters set.

? Spiralcut 1

[El Type: Spiralcut
v g Primary
k Frame
€ Features
B Tool and SpeedFeed
v [® Limiting
& Boundaries
@ Check
> iy Tolerance and Steps
> i Path Setting
v gy Link and Lead
o Link
ek lead In
o Lead Out
== Display

> [Eladvanced |

¥ Enable

Arcs

[ Fit Arc

Chord Tolerance 0.005
Max Radius 1e6

Reset

P

¢ 4 4 & % | E &

Calculate OK Cancel
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Chord Tolerance --Determines the accuracy of the arc

Max Radius -- Determine the max radius of the output G02/G03, if the radius of the fitted arc is greater
than Max Radius, GO1 will be output.

4.4 % New Arc Fitting Functionality in Surface Engraving Operation
and 5X Operations
In the past, the Surface Engraving and 5X operations can only output linear tool path, after added this Fit

Arc option, the generated tool path of surface engraving operation will be as close to the arc as possible.
And the 5x operations will output the arc in the XY, XZ, YZ planes of the coordinate of the operation.

v Surface Engrave 5

® Type: Surface Engrave ¥ Enable Arcs
~ g Prima
‘k Fra:e ¥ Fit Ave
& Features
1§ 100l and SpeedFeed
] Limiting
> Al Tolerance and Steps
i Path Setting
v g Link and Lead
ok Macro
o Link
ek Lead In
o Lead Out
= Display

> B Advanced

Reset Calculate OK Cancel

¢ 4 th & W & &

4.5 New Regular Pentagon, Hexagon and Octagon Turning Tools

New Regular Pentagon, Hexagon and Octagon Turning Tools support rough, finishing and facing
operations.

Pentagon Tool Hexagon Tool Octagon Tool
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1.  Support for output operation list in Excel format

4.6 *New Excel Format of Operation List

In ZW3D 2021, the operation list can be output in Excel format, user can customize the Excel
template as needed.

? CAM Operation List Settings

¥ Settings

~Select Template

Operationlist Template I OplistExcel.xsls

Custom Variables

Keyword ‘ Name | Value

OK

Cancel
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2. Support for show or hide the default coordinate

User can show or hide the default coordinate as needed; this determines whether it will be
displayed on the view of operation list.

Framoe
gl Toc <, Insert Frame

©aTac [ Insert Frame Folder
@ Op ﬁ Show /Hide World Frame

I ™
Oul t® Show All/Hide All

T

8 Show Datum Planes

@ Hide Datum Planes

X Delete All
Toggle Expand/Collapse

Customize menu

3. Support the output view of the specified coordinate system
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User can specify the coordinate system by Set/Cancel Active option of frame, then operation list will
output the view according to the active coordinate system.

v '( Frames
Frame 1 )
|< Frame 2 o _Edit
L Frame 3 I Set/Cancel Active
> W§) Tools B§ Rename
zTactics Duplicate
> Operations
Assign To All
> J Machine : v SHgn o

> Eoutput | 0w Show/Hide
Toggle Datum Planes

X Delete

Customize menu

4. Increased output speed

Output the Excel format is faster than the Html format about half the time.

4.7 Independent the Web Editor Program of the Zw3D Post

In ZW3D 2021, user can web edit the .znc file on the independent the web editor, no longer dependent
on Internet explorer and the port 8088.

¥ ZwPostConfig - m} X

ZW 3D

Default Property
Start of Program

Part Number

Block Sequence Number
Comment Block

Define Machine Functions

Automatic Tool Change
Define Words Properties
Define Sx Machine
Output Format

Tool length Compensation
Canned Cycles

Other Properties
Reverse Post functions
Output Spindle

Motion Parameters

End of Program

Edit Macros

ver2.210.00

Close ZW3D Post Editor
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New the progress bar in tool path verification, user can realize the simulation of drag and drop mode,

which is easy to find the problem of tool path.

& Toolpath Verify &3
v %] °
¥ Required

F 199.1683 MMPM
S 1000.0000 RPM

X-108.3868
-20.0000
I 0.0000) 0.0000

Y 121643 z

K 1.0000

Replay speed :

P Settings

4.9 Support the Left to Right Cutting Direction in Groove operation
In ZW3D 2021, The Groove operation can cut from left to right.
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@ Turn Groove 2 =
L} a
g-g Type: Turn Groove ¥ Cutting Control i |

~ g Primary .
|< Frame Cut Regions oD -
€ Features Cut Direction Left to Right hd
i Tool and SpeedFeed Cut Strategy Zigzag -
Limiti
15 Limi ng Relief Amount 0.2
> M Tolerance and Steps
@ Path Setting Stock Height 0
v b Link and Lead Dwell Time (s) 0.
eha Lead In Rough Clearance 1
= Display
Safe Distance 2 =
Output Type Custom -

Station Point

¥ Finish Cut

Finish Groove Yes hd

Finish Thick 0

Retract Position o]

Overlap 0.1 L

Back Off Distance 1 I
Reset Calculate OK Cancel

¢ O % % ¥ &H &

4.10 % Support the G68.2 Functionality

In ZW3D 2021, we support the G68.2 functionality; user can call corresponding function in
ZW_FANUC_5X.znc, ZW_SINUMERIK_5X.znc and ZW_HEIDENHANIN_5X.znc files.

4.11 New Limit Stepover Option in QM Roughing Operations

In QM Roughing Operations, we added a Limit Stepover option to restrict whether user can set big
stepover. The default setting of Limit Stepover is “Yes”, which means that the user cannot set the stepover
more than 90% tool flat diameter. If set to “No”, that user can set big stepover.
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@ Rough Lace 1 L X
E-TYPE: Rough Lace ¥ Advanced Setting
v ¢ Primary
k Frame Safe RAPID Traversal No -
& Features ILirnit Stepover Yes - I
l'"u Tool and SpeedFeed ¥ Enable Arcs
v Limiting
&7 Boundaries ) xv YZ Xz
Us Reference Tool Link AFC
@ Check Radius Range 0.1 10000

Bl Filters

> Mh Tolerance and Steps L el e

> @ Path Setting User Value
v g Link and Lead Eine 0.00 : DCoarse |
B Link
e Lead In Reduce Surface Mesh No =
e Lead Out
= Display

v g Advanced
% Path Pattern
4% Feed Control

E More Setting

Reset Batch Calculate | Calculate oK Cancel

¢ O M & % W &

4.12 New Stepdown Type and Stepdown items in Spreadsheet

In the Spreadsheet Interface — Operation View, we added Stepdown Type and Stepdown these two items
to show stepdown parameter in spreadsheet. User needs to configure them in the Item Config.

v Spreadsheet Interface - Operation View & R
Operation ‘ Type | Class ‘ Tool ‘ To... ‘ Dreg... | H reg... ‘ Tool Min ‘ Frame ‘ Toler... ‘ Step ... ‘ Step ...| Stepdown Type ‘ Stepdown ||Surface T... ‘ Z Sur... ‘ Speed ‘ Feed ‘ -
Profilecut 4 | Profilecut Finish  D10R0O 1 1 1 unavailable Frame... 0.005 % Too... 70 Uniform Depth 1 .15 0.15 4000 2500 =
Profilecut 1 Profilecut Finish D10R0O 1 1 1 unavailable Frame... 0.005 % Too... 70 Uniform Depth 1 .15 0.15 4000 2500
Profilecut 5 Profilecut Finish D10R0O 1 1 1 unavailable Frame... 0.005 % Too... 70 Uniform Depth 1 .15 0.15 4000 2500
Spiralcut 1 Spiralcut Finish D10R0O 1 1 1 unavailable Frame... 0.01 % Too... 70 Uniform Depth 6 -0.1 4000 1000
Profilecut 3 Profilecut Finish D10R0O 1 1 1 unavailable Frame.. 0.005 Absol... 0.08 Uniform Depth 1 0 4000 600
Profilecut 6 Profilecut Finish D10R0O 1 1 1 unavailable Frame.. 0.005 Absol... 6 Uniform Depth 1 0 4000 600
Profilecut 2 Profilecut Finish D10R0O 1 1 1 unavailable Frame... 0.005 % Too... 70 Uniform Depth 1 4000 600
Rough SmoothFlo... Rough Sm... Rough D10R0 1 1 1 Not calcul... 0.05 % Too... 45.0 | Absolute 0.5 .5 0.2 2400 2500 -
< [ | »
Feature View Reset Values Calculate All Item Config Export Spreadsheet = Import Spreadsheet Tactic Interface Cancel Save All
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4.13 Distinguish the Type of Input Value for the Speed Feed Table

In ZW3D 2021, user can select the type of input value in the speed feed table. It can be selected to
Percent or Numeric in Speeds table, and selected Percent, Rapid or Numeric in Feed rates table.

@ Tool D N
B % ¥ ¢
Name Load SpdFd

. Speeds . Feed rates

Units. RPM hd Units MMPM W

Speeds 1000.0 Feeds 250.0

Rapid Percent = |100.0 Rapid Rapid

Step-over Numeric = | 100.0 Step-over Percent = |100.0

Plunge Percent = 100.0 Plunge Rapid v

Engage Percent ~ 100.0 Engage Numeric ~ | 60.0

Retract Percent = 100.0 Retract Percent ~ 300.0

Traversal Percent = 100.0 Traversal Percent = 100.0

Slotcut Percent | 100.0 Sloteut Percent ~ 400 \j

Slowdown Percent ~ 100.0 Slowdown Percent ~ 60.0

OK Apply Reset Save All Cancel
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